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Abbreviation Used

e cSoC - customizable system-on-chip

e MSS — Microcontroller subsystem

e DDR3 SDRAM — Double data rate synchronous dynamic Random Access Memory
e CCC - Clock conditioning circuitry

¢ MSS CCC — CCC block inside the MSS component

e Fabric CCC - CCC block instantiated inside the FPGA fabric

e DDR - Dual data rate memory controller

e MDDR - DDR controller inside the MSS component.

e BFM - Bus functional model

e FIC — MSS fabric interface
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Interfacing SmartFusion2 SoC FPGA with
DDR3 Memory through MDDR Controller

Introduction

This tutorial demonstrates how to create a hardware design using the System Builder to access an external
DDR3 memory through the built-in hard ASIC MDDR controller in SmartFusion®2 system-on-chip (SoC) field
programmable gate array (FPGA) devices. This tutorial also shows how to functionally verify the design
using bus functional model (BFM) simulation. The SmartFusion2 SoC FPGA has up to two DDR controllers.
Those controllers are the microcontroller subsystem (MSS) DDR (MDDR) _and the. fabric DDR (FDDR)
controllers. The MDDR controller is a hard ASIC block in the SmartFusion2 SoC FPGA. The FDDR
controller is also a hard ASIC block which can be used to simplify the interfacing of different DDR memory
standards to the SmartFusion2 SoC FPGA fabric.

Note: The FDDR is not part of the MSS.

This design focuses on using the ARM® Cortex™'-M3 processor as a master that talks to an external DDR3
SDRAM memory through the MDDR controller. The MDDR controller interfaces with the Cortex-M3
processor through the 64-bit AXI bus interface.

Upon completion of this tutorial, you will be familiar with the following:

1. Creating a Libero® System-on-Chip (SoC) v11.3 project using the SmartFusion2 SoC FPGA

2. Configuring and generating the various hardware blocks-and clocking system using the System Builder
3. Creating and generating testbench using the SmartDesign testbench Generator feature
4

Performing functional level verification of the design using AMBA® BFM simulation in MentorGraphics
ModelSim® Simulator

5. Using the ModelSim GUI to see the various design signals in ModelSim Waveform window

Tutorial Requirements

Software Requirements
This tutorial requires the following software and MSS core version installed on your PC:
e Libero SoC v11.3.
e MSSv1.1.100

Associated Project Files

You can download the associated solution and source project files along with the readme for this tutorial
from Microsemi website:

http://soc.microsemi.com/download/rsc/?f=SmartFusion2_MDDR_DDR3_Tutorial_DF

Note: Extract the design files to root directory. The Source_files folder includes the MDDR_wave.do,
user.bfm and the DDR3 associated files.
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Design Overview

Design Overview

The design demonstrates the read/write access to an external slave DDR3 memory using the SmartFusion2
SoC FPGA. Inside the SmartFusion2 SoC FPGA, the Cortex-M3 processor acts as the master and performs
the read/write transactions on the external slave memory. These read/write transactions between the
Cortex-M3 processor and the external DDR3 memory are executed through the DDR bridge and the MDDR
memory controller, which are part of the MSS.

The DDR bridge block is basically responsible for managing the read/write requests from the various
masters to the DDR controller in the MSS block. The DDR bridge also connects the AMBA high-
performance bus (AHB) based masters such as the Cortex-M3 processor to AXI based MDDR controller.

The MDDR controller interfaces with the DDR bridge through a 64-bit AMBA AXI interface and with the
external DDR3 memory through the SmartFusion2 SoC FPGA DDR 1/Os. The MDDR controller takes care
of converting the AXI transactions into the DDR3 memory read/write transactions with appropriate timing
generation. It also handles the appropriate command generation for write/read/refresh/precharge operations
required for DDR3 memory.

The MDDR contains two 64-bit AXI interfaces, one dedicated.to the DDR interface and the other to the
FPGA fabric. The MDDR can be used either to interface with the external DDR slave memory or to interface
with the FPGA fabric through the DDR_FIC interface. The DDR_FIC interface provides either a single 64-bit
AXI interface, one(1) 32-bit AHB interface, or two(2) 32-bit AHB/interfaces to the FPGA fabiric.

The MDDR controller must be configured to match the external DDR memory specifications. In this tutorial it
is the DDR3 specifications. The configuration of the MDDR. can be defined in a file and the file can be
imported using the System Builder or using the DDR configurator. The configuration is done through the
CoreConfigP soft IP core which is the master of the configuration data initialization process. Upon reset, the
soft IP core CoreConfigP will copy the data from embedded nonvolatile memory (eNVM) to the configuration
registers of the DDR through the FIC_2 advanced peripheral bus (APB) interface based on user specific
configurations. The RESET mechanism of the overall system is managed by the soft IP core CoreResetP.
The CoreConfigP will notify the CoreRestP when the register configuration phase is complete. The MSS
interfaces with the CoreConfigP IP core through the APB interface (FIC_2) to initialize the MDDR controller
registers based on a user specified configuration file. Refer to the CoreConfigP and CoreResetP handbooks
in the IP Catalog of the Libero SoC software for more information.

The purpose of this tutorial is'to demonstrate the interface of the MDDR with an external DDR slave memory
through the MSS. The interface through the fabric is demonstrated in a different tutorial. In this design, you
will use the System Builder to configure the system clocks and the MDDR block to access the external
DDR3 memory through the MSS through the DDR 1/Os without going through the fabric.

In the SmartFusion2 SoC FPGA device, there are six clock conditioning circuits (Fabric CCCs) inside the
fabric and one. CCC (MSS CCC) block inside the MSS. Each of the CCC blocks has an associated PLL.
These CCC blocks and their PLLs provide many clock conditioning capabilities such as clock frequency
multiplication, clock division, phase shifting, and clock-to-output or clock-to-input delay canceling. The Fabric
CCC blocks inside the fabric can directly drive the global routing buffers inside the fabric, which provides a
very low skew clock routing network throughout the FPGA fabric. In this design, using the System Builder,
you_will-configure both the MSS CCC and the Fabric CCC blocks to generate the clocks for the various
elements inside the MSS and the fabric respectively.

Figure 1 shows an overall block diagram of the different blocks used in this design.
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Design Steps

SmartFusion2 cSoC FPGA

Figure 1. -Level iagram

Design Steps

Step I: Cre roject
1.

2. elect New Project. Enter the information as displayed in Figure 2.
sion2_Tutorial
an appropriate location (For example, C:/Microsemi_prj)

Type: Leave as Verilog

Speed: -1

Die Voltage: 1.2

Operating Conditions: IND

3. Select Use System Builder in the Design Templates and Creators of the New Project window.
4. Click OK on the New Project window.
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Step I: Creating a Libero SoC Project

Project

[] Enable Blodk Creation

MName: DDR.3_SmartFusion2_Tutorial

Location: E: Microsemi_prj
Prefered HOL type: @) Verleg () VHOL

Description:

i, Edit Tool Profiles...

Device

Family: SmartFusion2 -
Die: M25050TS -
Package: 396 FBGA -
Speed: -1 -

Core Voltage (V): : Ramp Rate:

Operating Conditions:

Range

Junction Temperature {C) IIND hd l -

Core Voltage (V) ’IND - l

[] system Controller Suspend Mode

PLL Supply Voltage (V): 2.5

Design Templates and Creators

Use Design Tool

Version

mrtFusionZ Micracontroller Subsystem (MS5) 1.1.100

Show only latest version

[ OK ] [ Cancel

Figure 2. New Project Dialog Box

5. Since you selected Use System Builder, as shown in Figure 2, the System Builder window opens, to
enter a hame for your system, as shown in Figure 3.
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Step I: Creating a Libero SoC Project

.- ]

X Systern Builder @

Enter a name for your system:

MDDR._system|

Help QK ] | Cancel

Figure 3. Create New System Builder Dialog Box

6. Enter MDDR_system as the name of the system and click OK. The System Builder dialog box is
displayed with the Device Features page, as shown in Figure 4.

G\ Systern Builder - Dewvice Features

> Device Features » )  Memaries

Memory
| M55 External Memaory
@ MDDR.
Soft Memary Controller. (SMC)
M35 On-chip Flash Memory [ eMYM )
Fabric External DOR. Memary { FODR )

High Speed Serial Interfaces

| SERDESIF_O
|| sERDESIF_1

Microcontroller Options

|| watchdog Timer
Peripheral DMA

Real Time Counter

Figure 4. SmartFusion2 SoC FPGA System Builder Configurator
7. Under Memory, check MSS External Memory and select MDDR. Leave all other options unchecked.

Click Next, the System Builder — Memory page is displayed, as shown in Figure 5. You will be using
the DDR3 external memory models for the purpose of this tutorial. Set the memory setting time to 200
us.

o DDR memory settling time (us): 200

When you use an external memory model, you need to wait for the memory to initialize (settling time)
before you try to access it. Since you are using the DDR3 memory model, you need to wait at least
200us.
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Step I: Creating a Libero SoC Project

The DDR controller must be configured to match the external DDR3 memory specifications. The
configuration is done through the CoreConfigP soft IP core, which is the master of the configuration data
initialization process. Upon reset, the soft CoreConfigP will copy the data from eNVM to the configuration
registers of the DDR controller through FIC_2 APB interface.

The System Builder enables you to import the register configuration file in which you defined the DDR
controller configurations. For this design a configuration file, DDR3_PHY_16_NO_ECC_BL8 INTER.txt, is
provided in the tutorial zip files. The configuration file is located under <project directory>\
DDR3_SmartFusion2_Tutorial\Source_files\DDR3 folder.

Import the register configuration file as follows:
e Click Import Configuration, as shown in Figure 5.

e The Import File window is displayed. Browse to the provided DDR3 configuration file
DDR3_PHY_16_NO_ECC_BL8_INTER.txt and import it.

After importing the register configuration file, confirm the settings as follows:
e Memory Type: DDR3

e Data Width: 16

e SECDED Enabled ECC: unchecked

[

G“ Systern Builder - Mermoaries

> Device Features » ) Memories » »  Peripherals

Confi
{ MDDR 3

DDR memory setting time (us): 200

[Import Cunﬁgurationl Expark Cunﬁguraﬁun] [Restore Defaults]

General Mermory Initislization | Memory Timing |

Memory Settings

Memary Type CDR3 =
DataWidth

SECDED Enabled ECC [T

Arbitration Scheme Type-0 -

Highest Priority ID

Address Mapping JROW, BANK, COLUMM}

Figure 5. System Builder Configurator — Memory Page
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Step I: Creating a Libero SoC Project

Select Next, System Builder- Select Peripherals page is displayed, as shown in Figure 6.
This tutorial will not use any MSS peripherals, therefore clear all the MSS Peripherals (marked on
Figure 6 below).

Since the system is using an MSS DDR (on the first page of the System Builder), the MSS_DDR_RAM
is shown under the MSS DDR FIC Subsystem, as shown in Figure 6.

(“ Systern Builder - Peripherals

= o s

> Device Features » »

Memaries ) » Peripherals » }  Clodks » > Microcontroller » > SECDED » ) Security » »  Interrupts » > Memory Map »

Select the peripherals and masters for each subsystem

Fabric Slave Cores Subsystems

Core

Corel2C 70102

1

2

3 CoreSPI 30156
4 CoreGPIO 30120
5 CoreTimer 11101
6 CorelUARTapb 5.2.2
7 CorePyit 41.106
8 Fabric AMBA Slave 00102

Version @ MSS FIC (0 - M55 Master Subsysten
drag and drop here to add to subsystearrn

MES FIC 0 - Fabrc Master Subsystem
drag end drop here to add to subsystam

MG A1 - MBS Master Subsysiem
drag and drop here to odd to subsysterm

MES AIE 1 - Fabric Master Subsystemn
drag and drop here to add to subsysterm

Fabric Master Cores =

Core

Fabric AMB&, Master 00102

Version

Confiqure Enable

| | o | | e

Masters are in bold and blue.

To mova a perpheral from one subsysfem fo anothey drag i from b present focabion and diag it onfo the des
You cannoé drag and drap onfo M55 Perpherals,

Help = Back Mext
Figure 6. System Builder Configurator — Select Peripherals Page
10. Select Next, System Builder- Clock Settings page is displayed, as shown in Figure 7. Select the

following options:

o System Clock: Set it to 100 MHz (default) and select Dedicated Input Pad from the drop-down list
e M3.CLK:100 MHz

¢ MDDR Clocks: Select 3 from the drop-down menu to get an MDDR_CLK of 300 MHz.

Note: You can see the clock and the different blocks it drives by clicking the clock name shown in Blue
color. For example, click the MDDR_CLK shown in Figure 7 and the clock and the blocks that the
clock is driving are displayed on the right-side panel.
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Step I: Creating a Libero SoC Project

-
(® System Builder - Clocks

EE——)

System Clock

100.00 MHz

> Device Features » > Memories  » » Peripherals » > Clocks

Configure clock requirements

Dedicated Input Pad

Cortex-M3 and M55 Main Clock

MDDR Clocks

MSS APB_0/1 Clocks

Fabric Interface Clocks

DDR/SMC_FIC_CLK =MDDR CLK/ 1~

APB_0_CLK =M3_ClK/ 100,000
APB_1 QLK =M3_CLK 100,000

w
FIC_0_CLK. =M3_CLK / 1 - g
FIC_1_CLK -m3ak/ [t = 3
Fabric DOR Clocks
FDDR_CLK = [100 MHz

FODR_SUBSYSTEM_CLK  =FODR CLK/ |1~

DOR- DDR Bridge
M3_CLK = 100.00 MHz 100.000 RAM

» > Microcontroller SECDED > 2 Security > > Interrupts » > Memory Map »

11.

12.

13.

14.

15.

16.

Figure 7. System Builder Configurator — Clock Settings Page
Click Next, the System Builder - Microcontroller Options page is displayed.
e Leave all the default selections
Click Next, the System Builder - SECDED Options page is displayed.
¢ Leave all the default selections
Click Next, the System Builder - Security Options page is displayed.
¢ Leave all the default selections
Click Next, the System Builder - Interrupts Options page is displayed.
o Leave allthe default selections
Click Next, the System Builder - Memory Map Options page is displayed.
¢ Leave all the default selections
Click Finish.
The System Builder will generate the system based on the selected options.

The System Builder block is created and added to Libero SoC project, as shown in Figure 8. The two
soft cores CoreResetP and CoreConfigP will automatically be instantiated and connected by the

System Builder. How these blocks are connected can be seen by opening the System Builder

component in the SmartDesign canvas and this is explained in the later section of this tutorial. Refer to

Opening the System Builder Component as SmartDesign section on 14.

12
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Step I: Creating a Libero SoC Project

Design Hierarchy g X E MDDR._system_top & X | =
= 4 — . =
R ——— B B oo B QA E ANDO
« O o
B XTLOSC_FAB (osc_comps.av)
BB XTLOSC (osc_compsw) MDDR_system_0
E=j_ RCOSC_1MHZ_FAB (osc_comps.v) FAB RESET N POWER OM RESET N L
By RCOSC_1MHZ (osc_comps.y) CLIKO PADB————— & CLKD_RAD " MSS_READY 1
4 w MDDR_system_top DEVEST_N DEVRST_N MODR FACSH@: === ===== pEHMNDDR PADS
MDDR_system FAB_CCC_PNSE
FAB_CCC GLO
INIT_PNSE
INIT_DONE
] [T N G
Desig... Design Hier... | Stimulus Hie... I Catalog I Files | 1 " — — r

Figure 8. SmartFusion2 SoC FPGA System Builder Generated System
17. Connect the pins as follows:
e Tie the FAB_RESET_ N to high by right-clicking and selecting Tie High.

This is an active low reset input that comes from the user logic.in the fabric. In this tutorial as you are
not using this signal so you can tie it High.

e Mark the output port POWER_ON_RESET_N as unused by right-clicking and selecting Mark
Unused.

e Mark the output port MSS_READY as unused by right-clicking and selecting Mark Unused.
e Mark the output port FAB_CCC_GLO as unused by right-clicking and selecting Mark Unused.
e Mark the output port INIT_DONE as unused by right-clicking and selecting Mark Unused.

18. Generate the final system by clicking SmartDesign > Generate Component or by clicking Generate
Component & icon on the SmartDesign toolbar.

You can also right-click on the canvas and select Generate Component, as shown in Figure 9.

MDDR_system_0

4P B RESET N POWER_ON RESET NIpPX
)——— B CLKO PAD MSS_READY X
DEVRST N MDDR_PADSE@- - - - ----- @EMDDR DS |
FAB_CCC_PNSE
FAB_CCC GLO BPX

INIT_PINSE

INT_DONE X

2

Generate Compeonent

Auto Connect
Connection Mode
Add Port...

JIEH &

Figure 9. SmartFusion2 SoC FPGA Generated Final System

After successful generation of the system, the message “Info: 'MDDR_system_top' was successfully
generated. Open datasheet for details” is displayed on the log window.

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller 13
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Step I: Creating a Libero SoC Project

Opening the System Builder Component as SmartDesign

Upon generation, the System Builder configures, connects, and generates the entire MDDR system
including all the required blocks such as the MSS, clocks, CoreConfigP, and CoreResetP.

The final System Builder generated system is shown in Figure 9. You can dive into that block to see the
individual blocks that make-up the entire design. To do so, you can open the System Builder generated
block using the SmartDesign. It enables you to check the internals of the overall design. To open the
MDDR_system using the SmartDesign, use the following steps:

1. Inthe Design Hierarchy, expand MDDR_system_top component.
2. Right-click the MDDR_system and select Open as SmartDesign, as shown in Figure 10.

s El

4 il work
E=§|_ KTLOSC_FAB (osc_comps.wv)
E=f[ ATLOSC (osc_comps.yv)
E=f[ RCOSC_1MHZ_FAB (osc_comps.v)
E| RCOSC_1MHZ (osc_comps.v)
4 @ MDDE_system_top
{IE] MDDR_system

Set AsRoot
Instantiate in MDDR_system

Open Component
Generate Component

Open as SmartDesign...

' o &

Open HOL File

[ Files | _Stimulus Hie.o. | Design Check HDL File

Figure 10. Open as SmartDesign Option

The system will. be converted to a SmartDesign component and you will get the message, as shown in
Figure 11.

@ ‘Your design 'MDDR._system' has been successfully converted to SmartDesign.

Figure 11. Successful Conversion of System Builder to a SmartDesign Message

14
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Step I: Creating a Libero SoC Project

3. Click OK. The entire system will be shown in the SmartDesign canvas, as shown in Figure 12.

CORERESETP_0
RESET_N_M2F FAB_RESET_N

AC 2 APB_M_PRESET N RESET_N_FZM

FOWER_ON_RESET_N M3_RESET_N
4 EXT_RESET_IN_N USER_FAB_RESET NP X

USER_FAB_RESET_IN_N MDDR_DDR_AX| S_CORE_RESET NP X f-}-F-pommcmmocomomoemaoaon '
RCOSC_25_50MHZ INT_DONEp - - L NT_PI H
s 8 LK BASE : :
RCOSC_25_50MHZ_O2F| CONFIG_DONE ; i
i CLR_INT_DORE ! !
il ! !
i i
i H
f i
= ;
i
i

SYSRESET_POR i Tt
DEVRST N DE/RST_N POWER_ON_RES! EI'_E{ :
N i

i 2% I R
. ' [} i Yy
i w52
H o o8
H ooy
H mw ! Z9
i ppinz
H == 08 =w
i CORECONFIGP_0 "Il'll'Tll_.-—
' gFw|l == |2
i B2 &
i £= |
' om =
H =z | |
H Moy
H = an
H [
H
H B3
LW
= m
oo
0O =
L et
b= [}
oS
T
MDDR_system_MSS 0
MCCCLCLK_BASE M3S_RESET_N_M2F
MCCC CLKUBASE PLL LOCK FIC_2_APS_M_PRESET_NRp—
MSS_RESET_M_F2M AC_2_APB_M_PCLK
WDDR_APB_S_PRESET_N MDDR_ARDSE @ENOOR 0
WMDDR_APB_S_POLK
W3_RESET_N
el

Figure 12. System Builder Generated System Opened in the SmartDesign

Notice that the System Builder is automatically instantiated and connected different blocks based on the
different options that you have selected in the different pages of the System Builder.

e SYSRESET POR: It.generates the power-on reset signal for the CoreResetP block.

o CORERESETP_O(soft core): It is responsible for managing all the reset mechanism needed for the
system.

¢ FABOSC_O: It generates the clock source for the CoreResetP block.

e CCC 0: Itisused to generate the clock source for the MSS_CCC MCC_CLK_BASE reference. The
MSS_CCC, which is part of the MSS, gets the reference clock from the Fabric CCC (CCC_0).

o CORECONFIGP_0 (soft core): It is responsible for managing the configuration aspect of the controller
based on the specified configuration file.

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller 15
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Step 2: Generating the Testbench

Step 2: Generating the Testbench
In this step you will create a testbench for the design using the SmartDesign Testbench Generator.

1. Enable the SmartDesign simulation cores by selecting Simulation Mode check box in the Libero SoC
IP catalog, as shown in Figure 13. The IP catalog will display three simulation cores to drive the device

under test (DUT):
e Clock_Generator
e Pulse_Generator

e Reset_Generator
Note: If they appear in italic, double-click to download the cores to your local vault.

4 - Simulation Mode & -~

Marme . Version
4 (lock & Management y
iClock_Generator {101
Pulse_Generator 1.01
Reset_Generator 1.01

Description: Clodk_Generator
Time Units in picoseconds

|F||v.=_-s | Stimulus Hiera... | Diesign Hiera... | Deszign ... Catalog

Figure 13. Simulation Cores in the Libero IP Catalog
2. Double-click the Create SmartDesign Testbench in the Libero Design Flow window, as shown in
Figure 14.

MODR_system_top 3 Q ﬁ
-~

Tool
v 4 ¥ Create Design E
&5 System Builder
7 &5 Configure MSS

EY Create SrartDesign
Create HDL
| |ﬁ Create SmartDesign Testbench :
Create HDL TestBench
5 View/Configure Firmware Cores
4 p Verify Pre-Synthesized Design
B simulate il

|F|Ies I Stimulus Hier... I Design Hier... Desig... Catalog

Figure 14. Opening SmartDesign Testbench
3. The Create New SmartDesign Testbench dialog box is displayed, as shown in Figure 15.

16 Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller
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Step 2: Generating the Testbench

4. Enter MDDR_system_testbench in the Create New SmartDesign Testbench dialog box and click
OK.

P

7| Create Mew SrmartDesign Testbench @

Marme:

MDDR._system_testbench |

Set as Active Stimulus

o) o

Figure 15. Create New SmartDesign Testbench Dialog Box
5. The SmartDesign canvas will open with the MDDR_system_top_0 component instantiated, as shown in

Figure 16.
StartPage E MDDR_system_top E MDDR,_system™® Ej MDDR._system_testbench® @

m

MDDR_system_top 0

CLKO PAD = MDDR PADSEH@
DEVRST.N

1 ' m. - b

W& VIR

BP P

Figure 16. SmartDesign Testbench Canvas

6. Drag the Clock_Generator and Reset_Generator simulation cores from the IP catalog to the
MDDR_system_testbench SmartDesign canvas.

7. Open the Reset_Generator configurator by double-clicking RESET_GEN_0 in the SmartDesign
canvas. Ensure that the following information, as shown in Figure 17, is set in the RESET_GEN_0
configurator and click OK:

e Level: ACTIVE LOW (default)
e Programmable Delay (ns): 1000
The reset generator will provide the reset pulse for the simulation.

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller 17
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Step 2: Generating the Testbench

i T —
[, Configuring RESET_GEN_0 (RESET_GEN -... [EENECE

Configuration

Level | ACTIVE Low - |

Programmable Delay (ns) 1000

Help [ QK J [ Cancel

Figure 17. RESET_GEN Configuration

8. Open the Clock_Generator configurator by double-clicking the CLK_GEN_0 in the SmartDesign
canvas. Ensure that the following information, as shown in Figure 18, is‘set in.the CLK_GEN_0
configurator and click OK:

e Clock Period (ps): 10000

e Duty Cycle (%): 50
Since you indicated that the System Clock is equal to 100 MHz, as shown in Figure 7, the clock generator
period is set to 10000 ps to generate this 100 MHz clock.

- ___ A g
[, Configuring CLK_GEN_0 {CLK_GE.i[:EI'ﬂAE
Configuration
Clock Period (ps) 10000
Duty Cyde (%) -ED 4
Help N [ QK ] [ Cancel

Figure 18. CLK_GEN Configuration

9. Import the provided DDR3 models into the Libero SoC project then instantiate those models into the
testbench that you created in the previous steps. The DDR3 model must be imported as Stimulus files
as follows:

e File > Import Files > HDL Stimulus Files. This opens the Import Files dialog box
e Select HDL Stimulus Files (*.vhd *.v) option from the Files of type, as shown in Figure 19.

e Select the provided ddr3.v and the ddr3_parameters.v files and click Open, as shown in Figure 19.
The files are located under the <project directory>\DDR3_SmartFusion2_Tutorial\Source_files
\DDR3_folder.
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My Computer
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Places
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2%

Fllddr3_parameters.v

File name: I"ddrBJaalameters.u" "ddr3a”

=l Qpen

Files of type: IHDL Stimulus Files *.vhd ~v)

LI Cancel

L

Figure 19. Import the DDR3 Models‘as Stimulus Files

Verify that the files are imported correctly as stimulus files by checking under the Stimulus folder in the
Files tab, as shown in Figure 20:

&[4 component
-] constraint

- [ «coreconsole
- B DDR3_SmartFusion2_Tutorial.prix
=+ [03 designer

= [ firmware

- 27 hdl

1 phy_synthesis
- [ simulation

- [ smartgen
=[] stimulus

~ [ synthesis
-7 tooldata
F- [ wviewdraw

& E ddr3.v
8 E5 ddr3_parameters.v

|Ca13lng || Design Hie... | Files | Desig... || Stimulus Hie...

Figure 20. Imported DDR3 in Stimulus Folder
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When the file is imported as a Stimulus, the file will also show in the Stimulus Hierarchy window, as
shown Figure 21.

sron:
s il work

> .E'=j_ testbench (testbench.v)
> [B] testbench (testhench.v)
p E=f[ testbench (testbench.v)

5 MDDR system_testbench
» ddr3 (ddr3.v)

[] Show Root Testbenches

Stimulus Hie .. | Design Hier... Desig... Catalog

Figure 21. Stimulus Hierarchy Window:
10. From the Stimulus Hierarchy window, drag-the ddr3 file into the MDDR_system_testbench canvas.

You are basically instantiating the DDR3 models-into the testbench to emulate an external DDR3
memory. You are going to simulate the write' and read from the DDR3 using the Cortex-M3 processor
as the master through the MDDR controller in the MSS. After you instantiate the DDR3, the canvas is
displayed, as shown in Figure 22.

ddr3_0

CLK_GEN O r?(t_n tdgs_n[1:0]10>
- - c
MDDR_system_top_0 Eﬁg"
CLKO_PAD MDDR_PADSE cs_n
DEYRST_N ras_n

g- cas_n

we_n
dm_tdqgs[1:0]
ba[2:0]
addr[13:0]
dqg[15:0]
dgs[1:0]
dgs_n[1:0]
odt

GFFE

Figure 22. System Testbench Canvas with DDR3 Models Instantiated

The next step is to connect all the blocks on the testbench canvas. There are two different ways to make the
connections. The first method is by using the Connection Mode option.

To use the Connection Mode method, change the SmartDesign to connection mode by clicking the
Connection Mode on the SmartDesign toolbar, as shown in Figure 23. The cursor will change from the
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normal arrow shape to the connection mode icon shape. To make a connection in this mode, click the first
pin and drag-drop to the second pin that you want to connect.

% StartPage St

+—'|Cnr1nectinn Mode

L

Figure 23. Enabling the Connection Mode Option
The second method to connect is, by selecting the pins to be connected together, right-click and select

Connect.

To select multiple pins to be connected, select a pin, hold down the CTRL key while selecting the other pins,
right-click the input source pin, and select Connect to connect all the pins together. In the same way, select
the input source pin, right-click, and select Disconnect to disconnect the signals already connected.

11. Using whichever connection method described above, make the following connections in the
SmartDesign canvas between the RESET_GEN_0; CLK_GN_0 and the MDDR_system_top_0:

e From RESET_GEN_0: RESET to MDDR_system_top_0:DEVRST_N
e From CLK_GEN_0:CLK to MDDR_system_top_0:CLKO_PAD

12. Expand the MDDR_system_top_0: MDDR_PADS. Using whichever connection method described
above, make the following connections iin the:SmartDesign canvas between the MDDR_system_top_0

and the ddr3_0:

e Connect MDDR_DQS_TMATCH_O_IN to MDDR_DQS_TMATCH_0_OUT of the
MDDR_system_top_0 block.

e Connect the rest of the'pins, as shown in Table 1.

Table 1. DDR3 Pins Connections

MDDR_System_Top_0_Pins DDR3_0_Pins
MDDR_CAS_N cas n
MDDR_CKE cke
MDDR_CLK ck
MDDR_CLK_N ck_n
MDDR_CS_N cs_n
MDDR_ODT odt
MDDR_RAS N ras_n
MDDR{RESET_N rst_n
MDDR_WE_N we_n
MDDR_BA[2:0] ba[2:0]
MDDR_DM_RDQSJ[1:0] dm_tdgs[1:0]
MDDR_DQI15:0] dq[15:0]
MDDR_DQS[1:0] dgs[1:0]
MDDR_DQS_N[1:0] dgs_n[1:0]
MDDR_ADDRJ[13:0] Addr[13:0]

MDDR_ADDR[15:14]

Mark Unused

Interfacing SmartFusion2 SoC FPGA with DDR3 Memory through MDDR Controller
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There are buses on the MDDR_system_top_0 and the ddr3_0 that do not match in width. In order to connect
those buses, you need to slice them first to create an equivalent bus width that matches between the

MDDR_system_top_0 and the ddr3_0.

For example, the MDDR_ADDR [15:0] is a 16 bits bus while the addr[13:0] on ddr3_0 is a 14 bits bus. In
order to connect these two, MDDR_ADDR[15:0] needs to be sliced into two slices. The first slice is
MDDR_ADDR [13:0] and the second slice is MDDR_ADDR [15:14]. After doing the slicing, connect
MDDR_ADDR [13:0] to addr[13:0] and mark the MDDR_ADDR][15:14] as Unused.

To slice a bus, use the following steps:

¢ Right-click the bus and select Edit Slice, as shown in Figure 24. The dialog box is displayed, as shown in

Figure 25.

CLKO_PAD

DEVRST N

MDDR_system_top_ 0

VDDR_ADDR[15 /. Q:;nE-:t

VDDR_BA[ _
NMDDR_DQS _TMATCH (

I".m_[]".ﬂ_RDQS[}E QuickConnect...

Diséomriect

MDDR_DQ[1 |
MDDR DQS|  Hide et
MDDR DQS_N|  Renemeet..

Edit Slice...

Promote to Top Level

Figure 24. Creating a Bus Slice

MDDR_PADSE
MDDR_DQS_TMATCH 0_OUT
MDDR CAS_N
MDDR_CLK
MDDR_CLK_N
MDDR_CKE
MDDR_CS_N
MDDR_ODT
MDDR_RAS_N
N
N

rst_n
ck
ck_n
cke
cs_n
ras_n
cas. n
we_n

dm_tdgs[1:0]

ba[2:0]

addr[13:0]

ddr3 0
tdgs_n[1:.0] -

|

e Click Ejcon (cifcled in Figure 25) to add a slice. Since you need to add two slices, click B icon twice.

Then add the slices, as shown in Figure 25.
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m Edit Slices - MDDR_ADDR[15:0] [2][X]
Create glices of width |1 V| [ Add Slices ]

MODR_ADDR[15:0] [@» Left Right

oo

Figure 25. Edit Slices Dialog Box
e Click OK. This creates two slices of the MDDR_ADDR bus, as shown in Figure 26.
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3 CLKO_PAD
DEVRST N

MDDR_system_top 0

MDDR_PADSEH
MDDR_DQS_TMATCH 0_OUT

-

A Lx])

i
-

2:0]

MDDR_DQS TMATCI—I 0_IN
MDDR DM RDQS[1:0]
MDDR_DQ[15:0]
MDDR_DQS[1:0]
MDDR_DQS_N[1:0]

450

Figure 26. MDDR_ADDR Created Slices
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13. Promote tdgs_n[1:0] of ddr3_0 instance to top by right-clicking on the pin and selecting Promote to
Top Level.

After making all the connections, the canvas is displayed, as shown in Figure 27.

MDDR_system_top_0

CLKO_FAD NDDR_PADSE
el DEVRST_N WDDR_DQS_TMATCH_0_OUT
WODR_CAS_ N
WOBR_CLK
MDDR_CLK_N
WDDR_CKE
WDODR_CS_N
MDDR_CDT
MODR_RAS_N
MODR_RESET om_tois[1:0]
MOER_WE N 2
MDDR_ADDR[150]@
WDDR_BA[2:0]
MODR_DQS_TWATCH_0_IN : :
WDDR D_RDQS[1:0] : dgs_n[1:0]
WDCR_DO[15:0] it
WODR_DES[1:0]
MDDR_D@S_N[1:0]

Gu.

ddr3_0 l
tos_r{10] 155 MR

gl

Figure 27. Fully Connected MDDR System

14. Generate the final system testbench by clicking SmartDesign > Generate Component or by clicking
Generate Component & icon on the SmartDesign toolbar. You ean also right-click on the canvas and
select Generate Component.

On successful generation, the message “Info: 'MDDR_system_testbench' was successfully generated”
is displayed on the log window:

15. After generating the testbench, you need to make it'Active testbench. By doing so you are specifying
the testbench that should be used for simulation. To set the testbench as the active testbench, use the
following steps:

1. Goto the Stimulus Hierarchy tab
2. If not already set, right-click the MDDR_system_testbench and select Set as active
stimulus, as shown in Figure 28.

Stimulus Hierarchy

Show: [] show Root Testbenches

= il work
l &) testbench (testbench.v)
Fﬁ_ testbench (testbench.v)

H-H -

Open Component
% Generate Component

Set as active stimulus

£/ QOpen HDLFile X

Check HDL File |
Catalog | Stimulus Hierare...

Delete from Project

Figure 28. Setting a testbench as Active testbench
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Step 3: Modifying the BFM Scripts

In this step you will modify the BFM script (user.bfm) file that was generated by the SmartDesign. The BFM
script file simulates Cortex-M3 processor writing/reading to/from the DDR3 model through the MDDR.

1. Open the user.bfm file. To open the user.bfm, go to the Files tab > Simulation folder, double-click the
user.bfm. The user.bfm file will open, as shown in Figure 29.

e E MDDR_system_top E MDDR_system™ Q MDDR_system_testbench user.bfm @ 4
[] constraint » P
D coreconsole . . - 2 # Enter your BFM commands in this file.
B DDR3_SmartFusion2_Tutorial.prix 33
[0 designer 4 # Syntax:
[ firmware 53 _—___
[ hdl 63
[ phy_synthesis 7 # memmap resource_name base_address;
=[] simulation 8 3
B bfmtovec.exe 9 # write width resource_name byte_cffset data;
B CompileDssBfm.tcl 10 # read width resource name byte offset;
By MDDR_init.bfm 11 # readcheck width resocurce_name byte_ocffset data;
B modelsim.ini 12 ¢
13 #

B peripheral_init.bfm

subsystem.bfm
I% Sy 15 include "subsystem.bim"

B test.bfm -
& userbfm |
H . 17 procedure user main;
[ smartgen 18 -
= [ stimulus 19 # perform subsystem initialization routife
B ddr3.wv 20  call subsystem init;
B ddr3_parameters.v 21
3 synthesis 22 2 gdd your BFM commands below:
[7 tooldata 23
[ viewdraw = 24 return
Catalog Design Hie... Files Desig... Stimulus Hie... \ W 4 ]

Figure 29. SmartDesign‘Generated user.bfm File
2. Modify the user.bfm to add the following bfm‘commands of writing and reading and click Save.
# add your BFM commands below:

# DDR memory map
memmap M_MDDRO_SPACE_0 0xA0000000;

[

print "TEST STARTS'';

#write different values to different location
write w M_MDDRO_SPACE_0O 0x0000 OxA1B2C3D4;
write w<M.MDDRO_SPACE O 0x0004 0x10100101;
write w M_MDDRO_SPACE_O 0x0008 OxD7D7E1E1l;
write w M_MDDRO._SPACE.O 0x000C OxA5DEF6E7;
write w.M_MDDRO_SPACE_0 0x0010 OxXABCDEFO1;
write w M_MDDRO_SPACE_0O 0x0014 OxCCBBAADD;

T

(¢

#read check what you wrote in step#b above
readcheck w M_MDDRO_SPACE_O 0x0000 OxA1B2C3D4;
readcheck w M_MDDRO_SPACE_O 0x0004 0x10100101;
readcheck w M_MDDRO_SPACE_O 0x0008 OxD7D7E1E1l;
readcheck w M_MDDRO_SPACE_O 0Ox000C OxAS5DEFG6E7;
readcheck w M_MDDRO_SPACE_O 0x0010 OxABCDEFO01;
readcheck w M_MDDRO_SPACE_O 0x0014 OxCCBBAADD;
print “"TEST ENDS";

Note: An updated user.bfm file is included in the source files folder (<project directory>\
DDR3_SmartFusion2_Tutorial\Source_files). You can import this file instead of manually modifying
the user.bfm file as follows:
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e Go to Files tab and right-click on the simulation Folder as shown in Figure 30.

» [ cormponent >

 [] constraint 1

> [ designer

B[] firrmware
[kl

4 ||1‘| sirmulatio

bfmtowvec

m

Import Files...

rDDR_init.bfrm
kDDR_systern_testhbench_presynth_simulati., —

modelsirm.ini
rnodelsirm.inisaw
peripheral_init.bfim
presynth

run.do
subsysterm.bfrn

Lt 1L

-

— PP P [ [ ([P [P ([P [P

Desig... Design Hier... Stimulus Hie... I Catalog | Files |

Figure 30.Importing bfm Source File

e Browse to <project directory>\DDR3_SmartFusion2_Tutoria\Source_files and select user.bfm and
select Open.

e A warning as shown in Figure 31 will come up. Select Yes.

P al
1| Warning ﬁ

w 4 |

5. < The file:'simulationuser.bfm' already exists,

Are you sure you want to replace it?

| wes || veswoal || w0 || nNowal

__N - >

Figure 31.Replacing Existing user.bfm File
o If the user.bfm file is already open in your Libero window, a warning as shown in Figure 32 will
come up. Select Yes. If the user.bfm is not already open in Libero window, the message will not
show up.

rEI Warning ~ > ﬁ

The file:'D: \Microsemiprj\DDR.3_SmartFusion2_Tutorial\simulationuser.bfm' has been modified outside of the Libero Text Editor,
JE\ Do you want to reload it?

[ Yes ][ ‘es to Al ][ Mo ][ Mo to All

Figure 32.Reloading and Updating user.bfm File
The following is an explanation for the different steps that you added into the bfm above.

e Step a): In this step you are specifying the base address at which the MDDR is located. In this case it is
0xA0000000
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e Step b): In this step you are writing different values to different locations. For example,
write w M_MDDRO_SPACE_0 0x0000 0xA1B2C3D4;
‘ A

Offset from base address Data to write

Writing a word

Base address

e Step c): In this step you are checking what you wrote. The final user.bfm is displayed, as shown in

Figure 33.
userbfm £
21
22 # add your BFM commands below:
23
24

25 # step a: DOR memory map
26 memmap M MDDRO SPACE 0 0xR0O000000;
27 print "TEST STRRTIS":

28

29

30 #3tep b: write different walues to different location
31 write w M_MDDRO_SPACE 0 0x0000 OxRIB2C304:
32 write w M_MDDRO_SPACE 0 O0x0004 0x102003071;
33 write w M MDDRO SPRCE 0 Ox000S540wDT7D7ELEL;
3 write w M MDDRO SPRCE 0 Ox0O0C 0xBSDEFGET;
35 write w M MDDRO SPRCE 0 Ox0010 O#RRCDEFO1;
36 write w M MDDRO SPRCE 0 Ox00T4 OxCCEBRADD;
37

38

39 #3tep c: read check what vou wrote in step "b' abowve
40 readcheck w M MODRO SPRCE 0 0x0000 OxR1B2C3D4;
41 readchetk w M MDDROCSPRCE 0 0x0004 0x10100101;
42 readcheck w M_MDDRO SPACE 0 0x0008 0xDTLDTELEL;
43 readcheck w M MDDRO SPRCE 0 Ox000C OxRSDEFEET;
44 readcheckyw M(MDDRO SPRCE 0 Ox0010 OxRBCDEFOL;
45 readcheck w M MDDRO SPRCE 0 0Ox0014 OxCCEBRADD;
45

a7

48 print "TEST ENDS":

8

all return

Figure 33. user.bfm after Adding the Commands

Refer to DirectCore Advanced Microcontroller Bus Architecture — Bus Functional Model User Guide for more
details.
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Step 4: Simulating the Design

1. Inthis step you will use the SmartDesign testbench and BFM script file to simulate the design. Open the
Libero SoC project settings (Project > Project Settings).

2. Select Do File under Simulation Options in the Project Settings window. Change the Simulation

runtime to 260us, as shown in Figure 34.

& Microsemi
Step 4: Simulating the Design

G‘ Project Settings

g Sa— —

Device
Device /O Settings
Preferred HOL Type
Design Flow
4 Simulation Options
DO File
Waveforms
Wsim commands
4 Sirmulation Libraries
SmartFusion2

Use automatic DO file
Simulation runtime:

Testhench module name:
Top level instance name:

[7] Generate veD file
WCD file name:

[ verilog 2001
[] system verilog

[ vHDL 2008

User defined DO file:

DO command parameters:

260us
MDDR_system_testbench

<top=_0

L Select Verilog Language Syntax

Select VHOL Language Syntax

Figure 34. Project Setting — Do File Simulation Runtime Setting
3. Select Waveforms under Simulation Options:

e Select Include DO file, browse to where you extracted the provided source files, and select
MDDR_wave.do file, as shown in Figure 35. In this file the list of signals that are required are already
selected soyou can check for the expected results.

e Select Log all signals in the design.
e Click Close to close the Project settings dialog box.
e Select Save when prompted to save the changes.
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@ Project Settings

Device
| Include DO fil .
Device /O Settings neuds = Save

Preferred HDL Type S{PROJECT_DIRE/../.. /Source_files/MDDR_wave.do Restore Defaults

Design Flow
4 Simulatien Options Display waveforms for [tcp_level MDDR _system_testbench - ]
DO File
| Waveforms
Wsim commands
4 Simulation Libraries
SmartFusion2

Log all signals in the design

Figure 35. Project Setting — Specifying the MDDR_wave.do File Location
4. Expand Verify Pre-Synthesized Design in the Design Flow window; as shown in Figure 38.
Double-click Simulate to launch ModelSim in GUI mode:

Design Flow

MDDR,_system_top E Q @'

Tool b’
v B b CreatesDesigh
- % System Builder
v - I% Configure MSS

- E% Create SmartDesign

Create HDL

4 Create SmartDesign Testbench
Create HDL TestBench

E5p View/Configure Firmware Cores

== b Verﬁ Pre- Sintheslzed DESIiI‘I

E- »# Constrain Design

: Import I/O Constraints

{3 Import Timing Constraints
= ¢ Implement Design

=" Synthesize

[ Constraints W

|Ca13|ug || Design Hierarchy || Files | Design Flow Stimulus Hierarchy |

Figure 36. Starting Pre-Synthesis Simulation
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Step 5: Validating the Simulation Results

1. ModelSim runs the design for about 260 us, as specified in the Project Settings window.

This will go through the initial process of initializing the MDDR by writing a specific set of configuration
options to the configurations registers. Once the configurations are written to the registers, then you can
write to the DDR3 memory. The results are checked by the readcheck command. The external DDR3
memory must initialize before it can be used. This is done by adding the 200us as specified in the
System Builder- Memory page, as shown in Figure 5. You can write and read from the external DDR.

2. The ModelSim transcript window will display the BFM commands and the BFM simulation completed
with no errors, as shown in Figure 39. Scroll in the window to see the different commands. In the BFM
script provided in the user.bfm earlier, the readcheck command reads the data‘and verifies whether the
data read matches with the value provided along with the readcheck command. If the value read does
not match, the simulation will show an error.

f=d Transcript e Hdl %
# MONRXIO: ##ddddddtddidtatididtdtiidtttididttddidttdd it tdadddtdddddddtsdd j
# MONRXIO: RCMD & ID:1 5SEQ:& RDDR:a&0000010 BURST:1 LEN:0 5IZE:3 LOCK:0 at 243994696 ps

# MONDDRC: READ REQUEST SEQ:6 TOKEN:d ADDR:a0000002 LEN:1 at 244004695 ps

# MDDE_asystem testbench.ddr3_0O.cmd_task: at time 244021572 ps INFO: Read bank Qgccl 008, [autc precharge 0

# MDDE_system testbench.ddrd_O.data_task: at time 244039905 ps INFO: READ @ DQS= bank = 0 row|= 0000 col = 00000008 data = ef0l

# MDLE_system testbench.ddr3_O.data_task: at time 244041572 ps INFO: REZD @ DQS= bank = 0O, row = 0000 col = 00000009 data = abcd

# MDDE_system testbench.ddr3_0O.data_task: at time 244043239 ps INFO: BEAD @ DQS= bank =0 rew = 0000, ccld= 0000000a data = aadd

# MDDE_system_testbench.ddr3_0O.data_task: at time 244044905 ps INFO: READ @ DQS= bark = 0 zow,= 00000 gl = 0000000b data = cckb

# MDDE_system testbench.ddrd_O.data_task: at time 244046572 ps INFO: READ @ DQS= bank = 0 row =,0000 col = 0000000c data = XHEX

# MDLE_system testbench.ddr3_O.data_task: at time 244048239 ps INFO: REZD @ DQS= bank = 0 row = 0000 col = 00000004 data = xxxx

# MDDE_system testbench.ddr3_0O.data_task: at time 244049905 ps INFO: READ @ DQS= bank\= 0 row = 0000 col = 0000000e data = xxxx

# MDDE_system_testbench.ddr3_0O.data_task: at time 244051572 ps INFO: READ @BQS= bank =)0 row /= 0000 col = 0000000f data = XHMX

# MONRXIO: RDAT Start ID:1 SEQ:6 - matching RCMD:& RDDR:a0000010 BURST:1 LEN:0 SIEE:S &t 818440 ps

# MONRXIO: RDAT ID:1 cchbbaaddabcdef0l at 244068029 ps

# MONRXIO: QUEUED 0 per ID=00 000000000000 00CHMDS=0000

# MONDDRC: EESF START TOEEN:d Request SEQ:6& ADDR:a0000002 LEN:1 from —808440 ps

# MONDDRC: RESF DATA TOKEN:d DATA:ccbbaaddabcdefOl End:0 at 244068029 p3

# MONDDRC: EESF DATZ TOKEN:d DATA:MNXXEMNMXXMMENNXX End:1 at 244074695 ps

# MONDDRC: QUEUED CMDS O

# BFM: Data Eead a0000014 cchbaadd MASK:Iff: £f at 244084.695360n3

FEtttdd ittt R A AR AR R A R AR A A

#

# i{SS BFM Simulaticn Complete - 4420 Instructicns - NO ERRCRS

#

Fdttiiddditid bttt R R A AR R R R H R A

#

# MDLE_system testbench.ddr3 O.cmd task: at time 244304905 ps INFO: Precharge bank 0

# MDDE_system_testbench.ddr3_0O.cmd_task: at time 244331572 ps INFO: Precharge Power Down Enter

VSIM 2= E‘
Mow: 260 us Delta: 2 sim: MDDR_system_testbench 259976922374 fs to 2600012145

Figure 37. ModelSim BFM Simulation Transcript Results

Once the simulation is run-completely, undock the Wave window. The Wave window can be undocked by
clicking the Dock/Undock icon on the Wave window, as shown in Figure 40.

[T wave - Default

Figure 38. Doc or Undock of ModelSim Wave Window

3. Once the Wave window is undocked, click the Zoom Full icon as shown in Figure 41 to fit all the
waveforms in the single view

[T wave - Default

2l S8 BRI

Figure 39. Zoom Full Option

4. Place the cursor around 243 ps on the Wave window and click the Zoom In on the Active Cursor icon
as shown in Figure 42, to zoom in at that location. That shows the time at which the data was
written/read-back to/from the DDR3 external modules, as shown in Figure 43 and O.
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Conclusion

Figure 40. Zoom In on Active Cursor Button
5. Figure 43 shows the time at which the data was written/read-back to/from the DDR3 external modules.

e =~

File Edit View Add Format Tools Bookmarks Window Help

5| Wave - Default 2 & x|
H-sE S shBL 2 0-AE [t a2 003 SHEBHT| Htaw 100 7= 4| el 4 8 5 | % @ |
eI I e EIBECCEENEE T . T

MDDR_system_testbench/RESET_GEN_0_RESET
/MDDR_system_testbench fCLK_GEN_0_CLK

/MDDR_system_testbench/MDDR_system_top_0_MDDR_CLK

/MDDR_system_testhench/MDDR_system_top_0_MDDR_CL...

MDDR,_system_top_0/MDDR_DQ j] D101 | J1010
#

m oo o '

Cursor 1 |248 ns

K1l ICH R0 S [ | |

243442289071 f5 to 243467963

Figure 41. Write/Read Data
That concludes this tutorial.
6. Quit the ModelSim simulator by selecting File > Quit.

Conclusion

In this tutorial, you created a new projéect in Libero SoC, configured the MDDR system using the System
Builder to access an external DDR3 SDRAM:memory through MDDR controller with the Cortex-M3
processor as master, created a testbench using the SmartDesign testbench generator, and finally connected
the different blocks using the SmartDesign tools.

Finally you verified the design in MadelSim using AMBA BFM simulation.

Appendix: VHDL Flow

If you are designing with VHDL, since the DDR3 memory models used here are in Verilog, you need to use
the ModelSim full version (for example, ModelSim SE) instead of ModelSim AE. ModelSim AE does not
support mixed-language flows. Use the following steps to simulate VHDL design:

1. Copy the precompiled VHDL simulation library folder smartfusion2 from the Libero SoC install area
(<Libero install> \Designenlib\modelsim\precompiled\vhdl\) to a different folder on your disk (for
example, E:\\Microsemi_prj\)

2. Remove the Read-Only attribute from the smartfusion2 folder at the new location.
Note: The reason for steps 1 and 2 is that ModelSim full version needs to refresh the precompiled

library. Those steps are to enable ModelSim full version to refresh the precompiled library and to
ensure that the original precompiled library, which is installed with the Libero SoC, is unchanged.

3. Simulate with automatic design optimization option disabled (-novopt) and point to the new precompiled
library location (for example, E:\Microsemi_prj\smartfusion2) in the Project Settings window as shown
below:

(@) Select Project Settings from the Project menu

(b) Select Vsim commands under Simulation Options. Add the —novopt option into the Additional
options field, as shown in Figure 36. The —novopt option disables the automatic design
optimization run.
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Appendix: VHDL Flow

Device ]
SDF Timing Delays
Preferred HDL Type " Y S
Design Flow © Minimum Restore Defaults
4 Simulation Options ) Typical
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SmartFusion2 Edditional options: —novopt:]
Help Close

Figure 42.Project Settings — Specifying —novopt.Simulation Option
(c) Select SmartFusion2 under the Simulation Libraries
I.  Clear Use default library path-option

Il.  Inthe Library path, enter the new location where you copied the precompiled library (for
example, E:/Microsemi_prj/smartfusion2), as shown in Figure 37.

() Project Settings E

Device @ ]
Preferred HDL Type selialtd hbT path_ - Save
Design Flow Library PEWEMGosaﬂiyjfwtﬁJsionzj E] Restore Defaults

4 Simulation Options
DO File
Waveforms

Wsim commands
4 Simulation Libraries
[ |SmartFusion2 ]

Figure 43.Project Settings — Specifying Precompiled Library Path
(d) Click Save to save the project settings and click Close to close the Project Settings window.
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Product Support

Microsemi SoC Products Group backs its products with various support services, including Customer
Service, Customer Technical Support Center, a website, electronic mail, and worldwide sales offices. This
appendix contains information about contacting Microsemi SoC Products Group and using these support
services.

Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades,
update information, order status, and authorization.

From North America, call 800.262.1060

From the rest of the world, call 650.318.4460

Fax, from anywhere in the world 408.643.6913

Customer Technical Support Center

Microsemi SoC Products Group staffs its Customer Technical Support Center with highly skilled engineers
who can help answer your hardware, software, and design questions about Microsemi SoC Products. The
Customer Technical Support Center spends a great deal of time creating application notes, answers to
common design cycle questions, documentation of known.issues and various FAQs. So, before you contact
us, please visit our online resources. It is very likely we have already answered your questions.

Technical Support

Website

Visit the Microsemi SoC Products Group Customer Support website for more information and support
(http://mww.microsemi.com/soc/support/search/default.aspx). Many answers available on the searchable
web resource include diagrams, illustrations, and links to other resources on website.

You can browse a variety of technical and non-technical information on the Microsemi SoC Products Group
home page, at http://www.microsemi.com/soc/.

Contacting the Customer Technical Support Center

Highly skilled engineers staff the Technical Support Center. The Technical Support Center can be contacted
by email or through the Microsemi SoC Products Group website.

Email

You can communicate your technical questions to our email address and receive answers back by email,
fax, or phone. Also, if you have design problems, you can email your design files to receive assistance. We
constantly monitor the email account throughout the day. When sending your request to us, please be sure
to include your full name, company name, and your contact information for efficient processing of your
request.

The technical support email address is soc_tech@microsemi.com.

My Cases

Microsemi SoC Products Group customers may submit and track technical cases online by going to My
Cases.
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ITAR Technical Support

Outside the U.S.

Customers needing assistance outside the US time zones can either contact technical support via email
(soc_tech@microsemi.com) or contact a local sales office. Sales office listings can be found at
www.microsemi.com/soc/company/contact/default.aspx.

ITAR Technical Support

For technical support on RH and RT FPGAs that are regulated by International Traffic in Arms Regulations
(ITAR), contact us via soc_tech_itar@microsemi.com. Alternatively, within My Cases, select Yes in the ITAR
drop-down list. For a complete list of ITAR-regulated Microsemi FPGAs, visit:the ITAR web page.
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